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Microsoft® SharePoint Products & Technologies
SharePoint Products and Technologies provide you enterprise-scale capabilities to meet businesscritical needs such as managing content and business processes, simplifying how people find and
share information across boundaries, and enabling better informed decisions. Using the combined
collaboration features of Windows SharePoint Services and Office SharePoint Server 2007 your
organizations can enable their users to create, manage, and easily build their own SharePoint sites,
and enable these sites to be discovered throughout the organization.

Tips & Tricks
Microsoft Windows SharePoint Services 3.0
Microsoft Office SharePoint Server 2007
Work More Effectively with Others
Site Templates – Windows SharePoint Services provides pre-built SharePoint site templates with
which you can quickly and easily create a professional site or workspace for collaborating with
colleagues. In addition to the team sites, meeting workspaces, and document workspaces available in
previous versions, WSS 3.0 also includes new templates for creating Wikis and Blogs. On the portal
home page, click the Site Actions button. Click Create Site.
Create a Wiki – A wiki site can be quickly set up to enable a group to brainstorm ideas, collaborate on
a team design, build an encyclopedia of knowledge, or just gather daily information in a format that's
easy to create and modify. On the portal home page, click the Site Actions button. Click Create Site. In
the Select a template field, click the Collaboration tab and select Wiki Site.
Create a Blog – A blog (short for weblog) consists of frequent short comments, called posts. The posts
are displayed in order, starting with the most recent comment, with the blogger’s name and the date
attached. On the portal home page, click the Site Actions button. Click Create Site. In the Select a
template field, click the Collaboration tab and select Blog.
Post to a Blog from Microsoft Office Word 2007 – You can now publish blogs directly from Office
Word 2007. You can configure Office Word 2007 to link directly to your blog site, and use the rich Word
experience to create blogs with images, tables, and advanced text formatting features. In Word 2007,
click the Microsoft Office Button. Click Publish. Click Blog.
Slide Libraries – You can use new SharePoint Slide Libraries to provide a centralized, server-based
storage area for all your personal or team presentations. With a Slide Library, if you or your teammates
have created a presentation and you need to use one or two existing slides, it is easy to find and insert
this content into your presentation without ever leaving Office PowerPoint 2007. You can also choose
to link slides in your current presentation to the server version of that slide within the slide library. If the
server version of that slide changes, you are automatically prompted to update your slides. When
finished, you can publish your new presentation to a Slide Library directly from Office PowerPoint 2007.
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Now other people can repurpose your content for their own work. On the Slides tab, in the Slides group,
in the Add Slide list, click Reuse Slides. In the Reuse Slides pane, click Open a Slide Library.
Offline Document Libraries – You can keep synchronized copies of SharePoint document libraries
and lists within your Outlook folders, making it easy to organize and browse documents in these
folders, just as you would any e-mail. You can work on these documents within their respective
applications in Office Outlook 2007 at any time, even when you are offline. When you are back online,
you can easily synchronize your changes with the server version. From a shared document library, click
Actions on the Shared Documents toolbar, then click Connect to Outlook.
Microsoft Office Groove 2007 SharePoint Files Tool – In some ways, Office Groove 2007 functions
as an extension of SharePoint Server 2007. The SharePoint Files tool offers all the capabilities of the
Groove Files tool with the added benefit of integration with SharePoint document libraries. You can
easily check out documents from a document library into your Groove workspace, collaborate on and
iterate those documents among your project team, and then publish them back to the document library
when you have finished. You can access and update the information in your workspaces whether or not
you are connected to the network.

Improve Business Insight
Enterprise Search – The newest generation of Search functionality in Office SharePoint Server 2007
provides an intuitive and flexible user interface, improved relevance, and the ability to search
unstructured and structured information such as databases and line-of-business applications. Search in
Office SharePoint Server 2007 also delivers the ability to search for people, based on their knowledge
and other factors (such as membership SharePoint-based audiences). Portal users can maintain
information about themselves on their profile pages in their personal sites. This information can be
indexed by Office SharePoint Server 2007 and used in queries.
Offline Task Lists – Task lists created on an Office SharePoint Server 2007 site can be connected to
Outlook 2007 so that they can be viewed and managed alongside your other tasks. Like OneNote
tasks, SharePoint tasks are visible in your To-Do Bar. In the SharePoint task list, click the Actions
button, then click Connect to Outlook.
Excel Services – Office Excel 2007, combined with Excel Services, a new technology in Office
SharePoint Server 2007, provides significant improvements for sharing data with greater security. With
Excel Services, you can render a spreadsheet dynamically in HTML for browser-based viewing. You
can permit others to view the entire spreadsheet or only parts of it. Providing universal access to
spreadsheet information in a browser helps you share data more easily and securely. External users
such as customers and business partners can access and interact with your data without the ability to
see formulae, macros, or other confidential business logic that might be contained in a spreadsheet.
Excel Services can be used only with Excel 2007 files that are stored in a SharePoint document library.
Open the file, click the Microsoft Office Button, click Publish, and then select Excel Services. Click
Excel Services Options to define which parts of your spreadsheet to publish.
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Excel Services (Parameters) – Spreadsheet authors can optionally name specific cells so they can be
used as parameters. Parameters are single cells in which Microsoft Office Excel Web Access users can
enter their own values. To name specific cells, click the Formulas tab. In the Defined Names group,
click Define Name. Review and Manage Content.
Document Versioning – You can compare different versions of a shared document provided you’ve
enabled versioning on your SharePoint document library. You can compare the latest version against
the last major or minor version or any specific version in the history. In your Office 2007 application,
click the Review tab. In the Compare group, click Compare.
Start a Workflow – To start a workflow, click the drop-down list for your document within your
document workspace or document library, and then click Workflows. Select the desired workflow, and
then click Start.
Participate in a Workflow – Integration with familiar client applications such as Office Outlook 2007
simplifies the workflow experience for users. For example, you can be notified of the workflow in
progress via e-mail. At the top of your email Click Edit This Task to open the Approval dialog box. From
here, you can open the workflow document and then approve or reject it, adding your comments if
necessary.
Track a Workflow – You can track the workflow progress and view the completion information in the
shared document library or document workspace. Click Workflows from the document drop-down menu
within your document workspace or document library.
Information Rights and Policy – You can use Office SharePoint Server 2007’s customized document
management policies to enable item-level access rights, retention periods, expiration actions, and
document-auditing settings. In a document library, click SettingsÆDocument Library Settings. Under
Permissions and Management, click Information management policy settings.
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Advanced SharePoint Site Tips & Tricks
Automating Business Processes
1. Form Libraries and InfoPath Forms – One of the most common and essential feature
requirements in enterprise Web Applications is the ability to accommodate forms-based business
processes. To create an InfoPath form library Click Site Actions Æ Create Æ Form Library Æ
Fill out the information Æ Create. Create an InfoPath Form and publish the Form Template to
the newly created Form Library.
2. Creating Form Workflows - By using SharePoint in conjunction with Office InfoPath Forms
Services, connecting an InfoPath form to an automated workflow becomes very easy and offers
great business solutions. In the Form Library, click Settings Æ Form Library Settings Æ Workflow
Settings Æ Fill in the appropriate options for the Form Library Workflows.

Personalizing Users’ Experience
3. Creating User Groups – SharePoint enables users to create customized User Groups in order to
help manage and organize different aspects of each SharePoint Site. To create a group: Click
Site Actions Æ Site Settings Æ People and Groups Æ New Æ New Group Æ Name the Group
and Give Permissions Æ Create. Once the group has been created, users have to be added to
each group. Click New Æ Add Users
4. Customizing WebParts – In SharePoint there are many out-of-the-box webparts that can be
used as is or customized to enhance the functionality of each site. Webparts can also be
downloaded online or custom built to satisfy many business needs. Click Site Actions Æ Edit
Page Æ Add a Web Part or Modify Shared Web Part

5. Audience Targeting – Being able to customize a webpart so that users only see documents that
pertain to them can help cut down on time they spend searching for relevant data. Audience
Targeting is successfully implemented by creating user groups and customizing weparts so that
the content shown is dynamically filtered depending of what group a user belongs to. To use
Audience Targeting from document library: Add a new Content Query WebPart Æ Edit the
WebPart to apply Audience Filtering. In a Document Library, click Settings Æ Document Library
SettingsÆ Audience Targeting SettingsÆ Enable Audience Targeting Æ OK. Insert the Target
Audience Column into the Document Library View Æ Click the drop down arrow next the
document you wish to target to a specific group Æ Edit Properties Æ type in the Group Name
into the Target Audience Field Æ OK. Once finished, go back to the main page and view the
Content Query WebPart showing only documents that are targeted to you.
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Advanced SharePoint Site Tips & Tricks
Managing and Implementing Enterprise Compliance Policies
6. Define a Policy – Records management capabilities in SharePoint give records managers the
ability to set up a records repository according to the organization’s file plan. In a document
library, click Settings Æ Document Library Settings Æ Information Management Policy Settings Æ
Define a policy Æ OK
7. Auditing Policies – Auditing policies can be turned on to log all activity against a record library,
and administrators have the ability to see reports on the usage. In the Auditing section, click
Enable Auditing.

8. Expiration Policies – The system also provides the ability to specify an action when the
expiration date is reached. The action either disposes the record or starts a workflow that can
allow the records manager to take action such as moving this record to a long-term archive. In the
Expiration section, click Enable Expiration

Application Integration
9. Microsoft Office Groove 2007 SharePoint Files Tool – In some ways, Office Groove 2007
functions as an extension of SharePoint. The SharePoint Files tool offers all the capabilities of the
Groove Files tool with the added benefit of integration with SharePoint document libraries. You
can easily check out documents from a document library into your Groove workspace, collaborate
on and iterate those documents among your project team, and then publish them back to the
document library when you have finished. You can access and update the information in your
workspaces whether or not you are connected to the network.
10. Groove Launchbar – The first thing you see when you start Office Groove 2007 is the Groove
Launchbar. This easy-to-use tool helps you manage and organize all your Groove activities,
including creating new workspaces, inviting others to workspaces, sending messages, monitoring
workspace and contact activity, and setting your personal Groove preferences.

11. Groove Files Tool – You can use the Files tool to work collaboratively with your teammates on
almost any type of computer file. Everybody in your workspace has access to those folders and
files.
12. Groove Discussion Tool – The Groove Discussion tool helps teams engage in a detailed
exchange of ideas in context of the work they are doing in the workspace.

13. Excel Services – Office Excel 2007, combined with Excel Services, a new technology in
SharePoint, provides significant improvements for sharing data with greater security. With Excel
Services, you can render a spreadsheet dynamically in HTML for browser-based viewing. You
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Advanced SharePoint Site Tips & Tricks
can permit others to view the entire spreadsheet or only parts of it. Providing universal access to
spreadsheet information in a browser helps you share data more easily and securely. External
users such as customers and business partners can access and interact with your data without
the ability to see formulae, macros, or other confidential business logic that might be contained in
a spreadsheet. Excel Services can be used only with Excel 2007 files that are stored in a
SharePoint document library. Open the file and click the Microsoft Office Button Æ Publish Æ
Excel Services Æ Excel Services Options to define which parts of your spreadsheet to publish.
14. Excel Services (Parameters) – Spreadsheet authors can optionally name specific cells so they
can be used as parameters. Parameters are single cells in which Microsoft Office Excel Web
Access users can enter their own values. To name specific cells, click the Formulas tab Æ Define
Name.

Exchanging Thoughts, Ideas, and Knowledge
15. Create a Wiki – A wiki site can be quickly set up to enable a group to brainstorm ideas,
collaborate on a team design, build an encyclopedia of knowledge, or just gather daily information
in a format that's easy to create and modify. On the portal home page, click the Site Actions Æ
Create Site Æ click the Collaboration tab Æ Select Wiki Site.
16. Edit a Wiki – To edit a Wiki, click the Edit button on the Wiki entry you wish to change or update
and edit the existing text. You can hyperlink to another Wiki page or create a new Wiki page by
enclosing the page name in double brackets. [[ ]]
17. Create a Blog – A blog (short for weblog) consists of frequent short comments, called posts. The
posts are displayed in order, starting with the most recent comment, with the blogger’s name and
the date attached. On the portal home page, click Site Actions Æ Create Site Æ click the
Collaboration tab Æ select Blog.
18. Post to a Blog from Microsoft Office Word 2007 – You can now publish blogs directly from
Office Word 2007. You can configure Office Word 2007 to link directly to your blog site, and use
the rich Word experience to create blogs with images, tables, and advanced text formatting
features. In Word 2007, click the Microsoft Office Button Æ Publish Æ Blog

Social Networking
19. My Site – My Site is a great place to start learning and working with SharePoint! It is a personal
site that gives you a centralized location to manage and store your documents, content, links, and
contacts. By Default, your My Site includes two parts: a personal site called My Home and a
public profile page called My Profile. Click My Site at the top right hand corner.
20. Social Networking WebParts – My Site serves as a point of contact for other users in your
organization to find information about you, your skills and interests. The Colleagues Web Part
helps you to keep track of events, such as whether your colleagues are in the office, in meetings,
or on the telephone.
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